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Introduction:
WinQuake was written to view and analyze Public Seismic Network (PSN), Princeton Earth
Physics Project (PEPP), SAC Binary, GSE2.0, and Standard for the Exchange of Earthquake Data
(SEED) volumes available on the Internet.

Features:
Event distance and magnitude calculation●   

Displays frequency spectrum (FFT) graph of the data set●   

Calculate lowpass, highpass, notch and bandpass FFT digital filters on the data set●   

Calculate lowpass or highpass Infinite Impulse Response (IIR) filters on the data set ●   

External ASCII table files for both phase travel-time and magnitude calculation●   

Jeffreys-Bullen (JB) and IASP91 travel-time tables for accurate distance and time of origin
calculation

●   

Calculate Ml, Ms, and Md magnitudes●   

Display arrival times for phases like PP, Pp, SS, SSS, PcP etc●   

Convert event files between Public Seismic Network, Binary SAC and ASCII formats●   

Export and Import data to and from ASCII text files●   

Calculate and locate the P and S markers if the event location and time are known●   

Built in Great Circle distance and azimuth calculator●   

Processing of event report services available on the Internet to update event file information●   

Historical event database lookup●   

Toolbar for commonly used commands●   

Data Integration●   

Send event files via Email directly from WinQuake●   

Request event files from PSN stations around the world●   

Web page based online documentation●   

Setup program for easy installation●   

System Requirements:
IBM PC or compatible.●   

Microsoft Windows 95/98, NT version 3.5 (or higher), Win2k, ME and XP.●   

Internet account to use Network Event Report and send event file Email features.●   
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Installation:
After downloading the self-extracting WinQuake setup program, execute the program using
Windows Explorer. You can also execute the setup program by opening a DOS box and typing the
name of the WinQuake setup program.

During the installation, enter the requested information in the dialog boxes. When you want to go
to the next dialog box click the Next button. When all of the information is entered, the setup
program will install the program in the directory you selected.

Using WinQuake:
The Open File dialog box is used to open event files. After opening an event file you can zoom
into a section of the seismogram by using the mouse or the X-Scale dialog box. To use the mouse,
do the following:

Move the mouse to the starting point on the graph where you want to zoom into.❍   

Double click and hold down the left button.❍   

Move the mouse to the end point. As you move the mouse a box should be drawn around the
area that will be displayed.

❍   

Release the left button. The program will then zoom into the selected area.❍   

To zoom out, select the Reset item under the View menu, press the RST toolbar icon, or use the
X-Scale dialog box.

WinQuake calculates distances between the event and the recording station by the user moving the
P and S markers to the beginning of the P and S waves on the seismogram. You must first enable
distance and magnitude calculation by selecting the Distance/Magnitude item under the Calculate
menu. See How WinQuake Calculates Distance for more information. If the magnitude correction
factor is known for the sensor, WinQuake will display the magnitude of the event. See How
WinQuake Calculates Magnitude for more information.

After picking the P and S waves, other phases like PP, PcP, SS, SSS etc, can be viewed by
selecting the Phases item under the View menu, or using the phase display toolbar icon. The Phase
Control dialog box is used to add or remove phases that will be displayed when this feature is
enabled. With the Event Location Map Window (see below), and three or more P and S picks from
different stations, the user can locate an event. 

The program can locate the P and S markers if the event location and time of origin are known. If
these fields are filled in, using the Event Report processing or the Event Information dialog box,
the program will use the currently selected travel-time tables and depth to calculate the location of
the P and S markers. Too activate this feature, use the P-S Location menu item under the Calculate
menu or the LOC icon on the toolbar.
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Location Map Window:
WinQuake can be used to locate an event using the Location Map Window. A typical
Location Map Window looks like this. After opening one or more event files and picking
the P and S phase, a map can be drawn showing the stations with a distance circle. This can
be used, if you have good P and S picks, to locate the event. Where the circles overlap, or
come near each other, is where the event occurred.

To open a Location Map window, click on the map tool bar icon next to the RST (Reset)
icon or use the "View/Locate Event" menu item. After opening a map window, you use the
Zoom menu to zoom in and out. To move the globe around, double click on a point on the
globe. This will move the map so that this point is now centered in the window.

Stations are marked with a triangle and a small square marks the location of the event, if the
event location is known. A small + marks the center point of the graph. On the left side of
the window, the cursor's location is displayed as well as the azimuth and distance from the
center point. Under the Cursor location is the Station color codes. The station markers and
distance circles are drawn with these colors. Under the Station information is the event
information, if the event information is known.

After locating an event using three or more event windows, an event report can be created
using the mouse. To do this, move the mouse to event location and right click. This will
open a floating menu bar. Select the Make Event Report menu item. WinQuake will now
make an event report based on the P and S picks in the event window. The time of origin
and the magnitude are calculated by averaging the data in each event window. The depth
comes from the current selected P and S travel-time table depth selected in the Travel-Time
Tables dialog box. The event location will be based on the location of the mouse at the time
the report is created. After calculating the information, WinQuake will open the Update
Event Report dialog box. This dialog box will display the report information and if the user
press the Update all Event Windows button, all of the event windows will be updated with
the new report information.

When using this Window, make sure you are viewing event files for only one event. If you
have event file windows open for more then one event you will have problems location the
event.

FFT Window and FFT Data Set Filtering:
To display a frequency spectrum of an event file, use the Full FFT or the View FFT items under
the Calculate menu, or use one of the two FFT toolbar icons. This will open another window
displaying a frequency spectrum of the complete data set, if you use the Full FFT menu or icon, or
do a FFT only on the data set being viewed, if the View FFT menu or icon is used. A typical FFT
Window looks like this.

The amplitude data of the FFT can be displayed either logarithmically or linearly by using the
Log-Y item under the Option menu. The Options menu can also be used to control the displaying
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of the X or Y grids, and turn the FFT Window's title bar on or off.

After you create a FFT graph window you can apply digital filters to the data set. Note: The IIR
Filter (see below) produces a more accurate filter then using the FFT method. Instead of using the
FFT window to filter the time domain data set, the user should use IIR filtering.  

Since filters are applied to the complete data set, filtering can only be done when the Full FFT
menu or icon is used. When the View FFT menu or icon is used, the filter icons and menu items
under the Calculate menu will be disabled.

The following filters can be applied to the data set:

Lowpass - Used to filter out high frequency information.❍   

Highpass - Used to filter out low frequency information.❍   

Notch - Used to remove a range of frequencies.❍   

Bandpass - Used to allow a range of frequencies.❍   

After applying one or more filters to the data set, you can convert the FFT information back to the
time domain (normal event graph) by selecting the Time Domain item under the Calculate menu,
or by using the Time Domain icon in the toolbar. When WinQuake finishes performing the reverse
FFT, the event data window used to create the FFT Window will be updated with the newly filter
data set.

When the "FFT View" feature is used, and the Auto FFT Display item is checked in the Event
Window's Calculate menu, you can view a new FFT of the viewed data set as you scroll through
the data using the vertical scrollbar.

The user can zoom in and display one decade at a time by using the magnifying glass toolbar icon
or using the mouse and clicking in area you want to zoom into.

Infinite Impulse Response (IIR) Filtering
This method of filtering is done directly to the data set and produces a more accurate filter
then the FFT data set filtering (see above). Unlike the FFT data set filtering, there is no need
to do an FFT before and after filtering the data. The process of doing the FFT causes small
inaccuracies when the frequency spectrum data is converted back to the time domain. 

To apply an IIR lowpass or highpass filter to the data set, open the Time Domain Filtering
dialog box using the Calculate / Time Domain Filter menu items or press the "F" toolbar
icon. After selecting the filter type, cutoff frequency and number of poles, press the Apply
Now button. The Undo Filter button can be used to undo the previous filter applied to the
data set. See the Time Domain Filtering dialog box for more information.

[ Top ] [ Next ]
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Event Window Information

Contents:
Text Information●   

Text Display Control●   

Data Set Display●   

Text Information:
Line 1: This line displays general information about the event file and recording station.

Start: Displays the start time of the event file. The (L) after the start time indicates that the data logging system was locked to
some time reference. A (?) after the start time indicates that the data logging system was locked to a time reference, but it was
been more then 24 hours since new time information has been received.

Station: Displays the recording stations name or location.

Samples: The number of analog to digital (A/D) samples in the event file.

SPS: Displays the sample rate in samples per second.
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Line 2: This line displays the comment and other information about the event file and event window settings.

Comment: Displays a comment about the event.

Max/Min: Displays the maximum and minimum A/D counts in the data set.

X: Displays the current X scale time.

Y: Displays the current Y scale value.

Line 3: This line displays the event report information.

Event Time: Displays the event origin time.

Lat/Long: Displays the event latitude and longitude.

Depth: Displays the event depth.

Mag: Displays the event magnitude.

Line 4: This line displays the calculated distance and magnitude based on the location of P and S markers.

Org: Displays the calculated time of origin of the event.

P: Displays the P marker time.

S: Displays the S marker time.

Diff: Displays the time difference between the P and S markers.

Dist: Displays the calculated distance based on the P and S time difference and the currently selected travel-time tables and
depth. The distance is displayed in degrees, kilometers and miles.

Mag: Displays the calculated magnitude(s).

JB: or Reg: Displays which travel-time table set is currently selected. Also displays the currently selected travel-time table
depth. When JB: is display, the teleseismic travel-time tables are active. When Reg: is displayed, the regional tables are
active.

Text Display Control:
Lines 1, 2 and 3 will be displayed if the Text item under the View menu is checked. Line 4 will be displayed when the
Calculate Distance / Magnitude option is checked in the Calculate menu. The PS toolbar icon can also be used to enable or
disable the distance and magnitude calculation.

The text font and size can be controlled by selecting the Font / Text Window   item under the Options menu.

The size of the text part of the display can also be changed by moving the bar separating the text and time domain graph.

Data Set Display:
Below the text information is the time domain graph of the data set. The X and Y grid can be turned on or off using the
Options menu. The data set can be inverted using the Invert Data item under the View menu.

You can zoom into a section of the seismogram by using the mouse or the X-Scale dialog box. To use the mouse,
do the following:

Move the mouse to the starting point on the graph where you want to zoom into.●   

Double click and hold down the left button.●   

Move the mouse to the end point. As you move the mouse a box should be drawn around the area that will
be displayed.

●   

Release the left button. The program will then zoom into the selected area.●   

To zoom out, select the Reset item under the View menu, press the RST toolbar icon, or use the X-Scale dialog
box.
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WinQuake Menu, Toolbar, and Status Bar Help

Contents:
Event Window - Menu and Toolbar●   

FFT Window - Menu and Toolbar●   

Location Map Window - Menu and Toolbar●   

No Open Windows - Menu and Toolbar●   

Status Bar●   

Event Window - Menu and Toolbar

The following menu and toolbar, if enabled, will be active when an event window is being displayed. Use the Toolbar item
under the View menu to turn the Toolbar on or off.

Menu Functions:

File:

Open... Ctrl+O

Opens the Open File dialog box. This dialog box is used to open new event files.

Save... Ctrl+S

Opens the Save File dialog box. This dialog box is used to save the current event file in one of the following
formats: PSN, SAC Binary or as a GIF image.

Close... Ctrl+C

Closes the current event window. If modified, you will be prompted to save the event file before the window
is closed.

Close All...

Closes all open windows.

Register Software...

Opens the Register Software dialog box. See register.txt for registration information.

Associate PSN File

Used to associate files ending in .psn to WinQuake. By associating a file type, programs like Internet
Explorer or you email program will open WinQuake when clicking on a PSN event file link ending in .PSN. 

Replay Settings...

Opens the Replay Settings dialog box. The Replay feature is used to create an event file using the remote
event file request feature of WinSDR or SDR (Seismic Data Recorder). See the WinSDR / SDR
documentation on how to setup and use this feature.
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Print... Ctrl+P

Prints the current event window.

Print Settings...

Opens the Print Settings dialog box.

Event Report...

Opens the Event Report dialog box. This dialog box is used to add event information (latitude, longitude,
magnitude and time of origin) to the current event file. See Using the Event Report Feature documentation
for more information.

Local Data Directory...

Uses the Directory dialog box to change were WinQuake looks for local data files. See Local Directory for
more information.

Tables Directory...

Uses the Directory dialog box to change where WinQuake looks for the Travel-Time table files. This setting
is saved in the WinQuake INI file.

Exit Alt+F4

Closes the application. You will be prompted to save any modified event files.

Directory List:
List of up to 8 directories used to hold event files. This list is updated when the Directory button in the Open
File dialog box is used.

Calculate:

Distance / Magnitude Ctrl+D

Used to display the distance and magnitude of an event. When enabled, a P and S marker will be displayed.
To move the markers, use the mouse or keyboard arrow keys. Holding the control key down and using one
of the arrow keys moves the marker faster across the screen. If you use the keyboard, press the P key to
move the P marker, S key to move the S marker, and M, D, or B if one of the magnitude marks are present.
The space bar toggles between the different marks. The last window of the Status Bar displays the marker
that is currently active. See How WinQuake Calculates Distance for more information.

Lock P-S Markers Ctrl+L

Locks the P and S markers to the X scale time. When the P and S markers are locked, they stay at the same
point in time as you move around the event file. If the markers are not locked, they will stay in the same
place on the screen as you move around the event file.

Reset P-S Markers Ctrl+R

Resets the P and S markers back to the lower left corner.

Picks...

Save Alt+K

Saves the current locations of the P and S markers and Travel-Time table settings in the event header
information. When a file has the picks saved, WinQuake will set the markers to this location when it
opens the event file.

View Picks

Moves the P and S marks to the location saved in the event file header information.

Clear Picks

Clears out the P and S Picks information set by the Save P-S Picks command.
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P-S Location

Places the P and S markers based on the event location and time of origin. This menu item will be dimmed
until event information is available. Use the Event Report dialog box to add event information to the event
file.

Switch Tables Alt+S

Toggles between using the regional and the teleseismic Travel-Time tables.

Magnitude Markers...

Ml & Ms Ctrl+K

Enables manual Ml & Ms magnitude calculation. See How WinQuake Calculates Magnitude for more
information.

Md Alt+Ctrl+D

Used to activate Md magnitude calculation. See How WinQuake Calculates Magnitude for more
information.

Great Circle Distance...Ctrl+G
Opens the Great Circle Distance Calculator dialog box. This dialog box is used to calculate the distance and
azimuth between two points on the earth.

FFT...

Full Ctrl+F

Creates a new FFT window with a frequency spectrum graph of all the data points in the event file.

View Only Ctrl+V

Same as above, but only does an FFT using the data points being displayed. You can not do FFT
filtering and converting back to time domain using this FFT function.

Auto FFT Display

Enables or disables the display of a new FFT graph when the event file is scrolled left or right. Only
active if the View FFT is used.

Window FFT

Enables or disables windowing of the data before the FFT is performed. If enabled you will not be
able to do FFT filtering.

Time Domain Filter

Opens the Time Domain Filter dialog box. Used to filter the data directly in the time domain.

STA/LTA Ratio

Opens the STA/LTA Ratio display dialog box.

RMS / Max / Min

Opens the RMS/Max/Min display dialog box.

Tables:
Opens the Travel-Time Tables dialog box. This dialog box is used to control what P and S wave Travel-Time table
files to use for regional and teleseismic events. It also controls what depth to use for each set of P and S wave
tables, and which set of tables to use. See How WinQuake Calculates Distance for more information.
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Display/Modify:

Event Information

Opens the Event Information dialog box.

Sensor Information

Opens the Sensor Information dialog box.

Time Information

Opens the Time Information dialog box.

View:

Undo

Undoes the last filter operation.

Copy

Copies the current event graph to the Windows clipboard. You can then paste the image into a paint program
for printing or converting to an image file.

Reset Alt+R

Resets the X and Y scales. This can be used to zoom out after zooming in using the mouse or the X-Scale
dialog box.

Phases

Display Alt+P

Toggles the display of arrival times for selected phases. Use the Phase Control dialog box to add or
remove phases that will be displayed when this option is enabled.

Phase Times Alt+Ctrl+P

Opens the Phase Time dialog box. Use the Phase Control dialog box to add or remove phase that will
be display in this dialog box.

Phase Control

Opens the Phase Control dialog box.

Integrate Data Alt+I

Used to integrate the data set. Integration converts acceleration to velocity and velocity to displacement.

Undo Integrate

Undoes the last integration operation.

Locate Event Alt-E

Opens the Locate Event Map window.

Data Points

Draws a + at each data point on the graph instead of drawing lines between them.

Invert Data

Inverts the data set as it is being drawn on the screen.

Web

Broadband Request...

Uses PSN Explorer to view the World Wide Broadband Station Request Data Form.
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New Event Files...

Uses PSN Explorer to view the new PSN event file list.

Event File Archives...

Uses PSN Explorer to view the PSN event file archive directory list.

PSN Explorer...

Opens PSN Explorer.

Status Bar

Toggles the bottom Status Bar on or off. This setting is saved in the WinQuake INI file.

Text

Displays the event file header information at the top of the event window.

Toolbar

Toggles the Toolbar on or off. This setting is saved in the WinQuake INI file.

X-Scale:
Opens the X-Scale dialog box. This dialog box controls the time scale of the event window. By changing the X
scale you can zoom in or out within the data set. Zoom in can also be done with the mouse.

Y-Scale:
Opens the Y-Scale dialog box. This dialog box controls data amplitude of the event window.

Options:

Arrange

When enabled, WinQuake will rearrange each window when a new event file is opened. If disabled, the new
event file window will be full size. This setting is saved in the WinQuake INI file.

Colors...

Seismograph Window...

Background...

Changes the background color of the current event window.

Print Background...

Changes the background color of the current event window when printing.

Graph...

Changes the data set graph color of the current event window.

Phases...

Changes the phase arrival time line color of the current event window.

P-S Markers...

Changes the P and S marker color of the current event window.

X-Grid...

Changes the X-Grid color of the current event window.

Y-Grid...

Changes the Y-Grid color of the current event window.
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Text Window...

Background...

Changes the background color of the current event window.

Data...

Changes the data text color of the current event window.

Labels...

Changes the data label text color of the current event window.

Note: All color settings are saved in the WinQuake INI file.

DC Offset

Opens the DC Offset dialog box. This dialog box is used to compensate for any DC offset in the data set by
applying an offset to the data displayed in an event window.

Distance

When enabled, distance calculation is turned on when a new event file is opened. This setting is saved in the
WinQuake INI file.

Fonts

Markers Font...

Used to change the P and S Marker font. This setting is saved in the WinQuake INI file.

Seismogram Font...

Used to change the text font in the seismograph window portion of the event window. This setting is
saved in the WinQuake INI file.

Text Window Font...

Used to change the text font in the text window portion of the event window. This setting is saved in
the WinQuake INI file.

Phases

If enabled, phase arrival time lines will be displayed when a new event file is opened. This setting is saved
in the WinQuake INI file.

Scroll Bars...

Vertical Bar

Toggles the vertical scroll bar of the current event window on or off. This setting is saved in the
WinQuake INI file.

Horizontal Bar

Toggles the horizontal scroll bar of the current event window on or off. This setting is saved in the
WinQuake INI file.

Title

Toggles the title bar of the current window on or off.

UTC Time

Displays X-Scale time at the bottom of the screen as UTC time (minutes:seconds) or as an offset in seconds
from the event file start time. This setting is saved in the WinQuake INI file.

X-Grid

Toggles the X-Grid of the current event window on or off. This setting is saved in the WinQuake INI file.
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Y-Grid

Toggles the Y-Grid of the current event window on or off. This setting is saved in the WinQuake INI file.

Window:

Arrange

Resizes all of the event and FFT windows to fit within the main WinQuake window.

Help:

Help...
Opens the main WinQuake Help document.

About WinQuake

Opens the About WinQuake dialog box. This dialog box has the version number, copyright, and author
information.

Toolbar Functions:

File / Open...●   

File / Save...●   

File / Event Report...●   

View / New Event Files...●   

Calculate / Save P-S Picks●   

Calculate / Distance●   

Calculate / P-S Location●   

Calculate / Md Marker●   

Calculate / Switch Tables●   

Calculate / FFT●   

Calculate / FFT View●   

Calculate / Integrate●   

Calculate / Time Domain Filter●   

View / Copy●   

View / Phases●   

View / Phase Time●   

View / Phase Control●   

View / Event Location Map Window●   

View / Reset●   

FFT Window - Menu and Toolbar
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The following menu and toolbar, if enabled, will be active when an FFT window is being displayed. Use the Toolbar item
under the View menu to turn the Toolbar on or off.

Menu Functions:

File:

Open... Ctrl+O

Opens the Open File dialog box. This dialog box is used to open new event files.

Save... Ctrl+S

Opens the Save File dialog box. This dialog box is used to save the current FFT graph as a GIF file.

Close... Ctrl+C

Closes the current FFT window.

Local Data Directory...

Uses the Directory dialog box to change were WinQuake looks for local data files. See Local Directory for
more information.

Tables Directory...

Uses the Directory dialog box to change where WinQuake looks for the Travel-Time table files. This setting
is saved in the WinQuake INI file.

Print... Ctrl+P

Prints the current FFT window.

Print Settings...

Opens the Print Settings dialog box.

Exit Alt+F4

Closes the application. You will be prompted to save any modified event files.

Directory List:

List of up to 8 directories used to hold event files. This list is updated when the Directory button in the Open
File dialog box is used.

Calculate:

Low-Pass Filter... Alt+L

Opens the Low-Pass or High-Pass Filter dialog box. Used to apply a low-pass filter on the data set.

High-Pass Filter... Alt+H

Opens the Low-Pass or High-Pass Filter dialog box. Used to apply a high-pass filter on the data set.

Notch Filter... Alt+N

Opens the Notch or Bandpass Filter dialog box. Used to apply a notch filter on the data set.

Bandpass Filter... Alt+B
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Opens the Notch or Bandpass Filter dialog box. Used to apply a bandpass filter on the data set.

Time Domain Alt+T

Converts the FFT data back to the time domain.

Amplitude Ratio File

Creates a file called RATIO.TXT in the WinQuake root directory. This menu item will be enabled if you
open two event files and do a FFT of each file. The event files should have the sample rate and number of
samples. The file shows the amplitude ratio between the two files for each FFT frequency bin. The first line
in the file is the lowest frequency that can be resolved my the FFT and the last line in the file the highest
frequency. This will be 1/2 the sample rate. The first number in each line is the frequency and the next
number the ratio.

View:

Copy

Copies the current FFT graph to the Windows clipboard. You can than paste the image into a paint program
for printing or converting to an image file.

Zoom In/Out

Zoom in or out. Zooming in displays one decade. Zooming out display all decades. The mouse can also be
used to zoom in or out by clicking inside the graph.

Higher Frequencies

When zoomed in this menu item can be used to move to the higher frequency decades.

Lower Frequencies

When zoomed in this menu item can be used to move to the lower frequency decades.

Broadband Request...

Uses PSN Explorer to view the World Wide Broadband Station Request Data Form.

New Event Files...

Uses PSN Explorer to view the new PSN event file list.

Event File Archives...

Uses PSN Explorer to view the PSN event file archive directory list.

PSN Explorer...

Opens PSN Explorer.

Options:

Log-Y

Toggles the amplitude display of the current window between logarithmic and linear. This setting is saved in
the WinQuake INI file.

Title

Toggles the title bar of the current window on or off.

X-Grid

Toggles the X-Grid of the current FFT window on or off. This setting is saved in the WinQuake INI file.

Y-Grid

Toggles the Y-Grid of the current FFT window on or off. This setting is saved in the WinQuake INI file.
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Window:

Arrange

Resizes all of the event and FFT windows to fit within the main WinQuake window.

Help:

Help...

Opens the main WinQuake Help document.

About WinQuake

Opens the About WinQuake dialog box. This dialog box has the version number, copyright, and author
information.

Toolbar Functions:

 

File / Open...●   

File / Save...●   

File / Print...●   

Calculate / Low-Pass Filter...●   

Calculate / High-Pass Filter...●   

Calculate / Notch Filter...●   

Calculate / Bandpass Filter...●   

Calculate / Time Domain●   

Zoom In/Out●   

Lower Frequencies●   

Higher Frequencies●   

Log / Linear●   

New Event Files●   

Location Map Window - Menu and Toolbar

The following menu and toolbar, if enabled, will be active when the Location Map window is being displayed. Use the Toolbar
item under the View menu to turn the Toolbar on or off.
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Menu Functions:

File:

Open... Ctrl+O

Opens the Open File dialog box. This dialog box is used to open new event files.

Save... Ctrl+S

Opens the Save File dialog box. This dialog box is used to save the map as a GIF file.

Close... Ctrl+C

Closes the Map window.

Exit... Alt+F4

Closes the application. You will be prompted to save any modified event files.

Print... Ctrl+P

Prints the current FFT window.

Print Settings...

Opens the Print Settings dialog box.

Event Report...

Opens the Event Report dialog box. This dialog box is used to add event information (latitude, longitude,
magnitude and time of origin) to the current event file. See Using the Event Report Feature documentation
for more information.

Directory List:
List of up to 8 directories used to hold event files. This list is updated when the Directory button in the Open
File dialog box is used.

Calculate:

Redraw

Redraws the map.

Make Event Report

When selected, WinQuake will create an event report based on the location of the mouse. The magnitude
will be an average of all of the open event windows.

Copy:

Copies the current map to the Windows clipboard. You can than paste the image into a paint program for printing
or converting to an image file.

Zoom:

Used to zoom in and out.

Options:

Colors...

Used to change the color of the first 8 station's distance circles, city markers, and event marker. Default is
used to reset all of the items back to there default color.

Display...
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Used to turn on or off some of the map features.

Font...

Cities...

Used to change the font of the city labels.

Text...

Used to change the font of the text information on the left size of the window.

Region Display

If enabled, the region string will be displayed in the status bar based on the location of the mouse pointer.

Window:

Arrange

Resizes all of the event and FFT windows to fit within the main WinQuake window.

Help:

Help...

Opens the main WinQuake Help document.

About WinQuake

Opens the About WinQuake dialog box. This dialog box has the version number, copyright, and author
information.

Toolbar Functions:

File / Open...●   

File / Save...●   

File / Print...●   

File / Event Report...●   

Calculate / Redraw●   

No Open Windows - Menu and Toolbar

The following menu and toolbar, if enabled, will be active if no event window is opened.
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Menu Functions:

File:

Open... Ctrl+O

Opens the Open File dialog box. This dialog box is used to open new event files.

Register Software...

Opens the Register Software dialog box. See register.txt for registration information.

Associate PSN File

Used to associate files ending in .psn to WinQuake. By associating a file type, programs like Internet
Explorer or you email program will open WinQuake when clicking on a PSN event file link ending in .PSN. 

Event Report...

Opens the Event Report dialog box. This dialog box is used to add event information (latitude, longitude,
magnitude and time of origin) to the event file. See Using the Event Report Feature documentation for more
information.

Replay Settings...

Opens the Replay Settings dialog box. The Replay feature is used to create an event file using the remote
event file request feature of WinSDR or SDR (Seismic Data Recorder). See the WinSDR or SDR
documentation on how to setup and use this feature.

Local Data Directory...

Uses the Directory dialog box to change were WinQuake looks for local data files. See Local Directory for
more information.

Tables Directory...

Uses the Directory dialog box to change where WinQuake looks for the Travel-Time table files. This setting
is saved in the WinQuake INI file

Print Settings...

Opens the Print Settings dialog box. The print margin settings are saved in the WinQuake INI file.

Exit Alt+F4

Closes the application. You will be prompted to save any modified event files.

Directory List:
List of up to 8 directories used to hold event files. This list is updated when the Directory button in the Open
File dialog box is used.

View:

Broadband Request...

Uses PSN Explorer to view the World Wide Broadband Station Request Data Form.

New Event Files...

Uses PSN Explorer to view the new PSN event file list.

Event File Archives...

Uses PSN Explorer to view the PSN event file archive directory list.

PSN Explorer...
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Opens PSN Explorer.

Help

Help...

Opens the main WinQuake Help document.

About WinQuake

Opens the About WinQuake dialog box. This dialog box has the version number, copyright, and author
information.

Toolbar Functions:

File / Open...●   

File / Event Report...●   

New Event Files...●   

Status Bar

If enabled, the following Status Bar will be displayed at the bottom of the main WinQuake window. Use the Status Bar item
under the View menu to turn the Status Bar on or off.

Status Bar Description:
First Window:

Used to display the cursor time and amplitude as well as program status and menu help information.

Second Window:

Displays the start time of the currently selected event file window.

Third Window:

Displays the X scale of the currently selected event file window.

Fourth Window:

Displays the Y scale of the currently selected event file window.

Fifth Window:

Displays the currently selected event file window marker (P, S, or magnitude markers M, D, or B) that will be
moved when the keyboard arrow keys are used.

[ Top ] [ Next] [ Previous ] [ WinQuake Help ]

Larry Cochrane - www.seismicnet.com/contact.html
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WinQuake Dialog Boxes
Main Control Dialog Box:

Open File

Directory

New Directory■   

❍   

Send E-Mail Message❍   

WinSDR / SDR Replay❍   

●   

Replay Settings

Replay Channel Information❍   

●   

Register Software●   

Event Window Dialog Boxes:
Data Operations●   

DC Offset●   

Great Circle Distance Calculator●   

Event Information●   

Event Report

Network Event Report

Add Network Report Service■   

Historical Data Lookup■   

❍   

●   

Phase Control●   

Phase Times Display●   

Print Settings●   

RMS / Max / Min Display●   

Save File

GIF Settings❍   

●   

Sensor Information●   

STA/LTA Ratio●   

Time Domain Filter●   

Time Information●   

Travel-Time Tables

New P or S Wave File❍   

●   

X-Scale●   

Y-Scale●   

FFT (Frequency Spectrum) Window Dialog Boxes:
High-Pass or Low-Pass Filter●   

Bandpass or Notch Filter●   
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Open File Dialog Box

Main control dialog box for WinQuake. Used to open or delete event files, open the WinSDR / SDR Replay dialog box, change the
working directory, or add event report information to the selected event file(s). You can also send the selected file(s) as an email
message and convert files from the old PSN Type 3 format to the new Type 4 format.

Files or File Name Edit Box:

Controls the File List box. Normally this string is set at *.* so all event files and data set volumes will be displayed.
You can change this string to show only one station's sensor event files by entering *. and the station ID file extension.
Example: *.LC1.PSN will show a list of all LC1 files in the current selected directory.

Directory Text:

Displays the currently selected directory. Use the Change Directory button, or one of the directories listed under the
File menu, to change the currently selected directory.

List Box:

Shows a list of event files that can be opened. To open an event file or display the contents of a SEED or PEPP data set
volume's event files, double click on the file name line in the List box. See below for more information about using the
List box.

Up / Down Control:

Used to control the the direction, either newer files on top or bottom, of the list box.

Open File Button:

Open selected event file(s) or display the event files within a PEPP or SEED data set volume. More then one event file
can be selected by holding down on the Ctrl key and clicking on the event file name. 

Add Event Report Button:

Used to add event report information to the selected PSN event file(s). This button will be dimmed if no event report
information has been selected. Use the Event Report dialog box to select an event report. If the selected event file
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already has an event report, you will be asked if you want to replace or add a new event report to the event file. See
Using the Event Report Feature documentation for more information.

Change Directory Button:

Opens the change Directory dialog box. Used to select the directory where WinQuake will look for event and data set
volume files. After selecting a new directory, WinQuake will reread all of the files in the new directory looking for
PSN, SAC, PEPP or SEED volumes. The new list of files will be displayed in the List box. If you set the Save as
Default check box, in the Directory dialog box, the new or current directory will become the new default. WinQuake
uses the default directory as a starting directory when the program first starts up. As you change directories the File
menu will show a list of up to 8 directories.

Send Email Message Button:

Opens the Send E-Mail dialog box. Used to send the selected event file(s) as email attachments. This button will be
dimmed if more than 4 event files are selected in the List box.

Convert Button:

Opens the Convert File dialog box. This dialog box is used to convert the selected file(s) to the new PSN Type 4 format
or change the file name to a long PSN file name.  

Replay Button:

Opens the Replay dialog box. The Replay feature is used to create event files using WinSDR or SDR over a network.
This button is dimmed if the file REPLAY.DAT is not located in the WinQuake root directory when WinQuake first
starts up. To create a REPLAY.DAT file use the Replay Settings item under the File menu.

Remote Button:

Opens the Remote File Request dialog box. The Remote File Request feature is used to send e-mail requests to PSN
stations for event files and station information. See the Remote File Request documentation for more information on
using this feature.

Update / All Files Button:

This button has two purposes. Normally the button is called Update and is used to update or refresh the List box by
reloading all of the files in the currently selected directory. The name of the button will change to All Files when the
contents of a SEED or PEPP data set volume are being displayed. Selecting the All Files button will redisplay the list of
event and data set volume files.

Delete File Button:

Deletes selected file(s). You will be prompted with a Delete File dialog box before files are deleted.

Help Button:

Opens this documentation.

Additional Information:
The file list box allows for multiple file selection. The Send Email Message, Open File, Add Event Report, Delete and
Convert functions can use more than one file for their operation. To select more than one file, hold down the left mouse button
and move it up or down. You can also hold down the Ctrl key and select individual files by clicking on the file name. Double
clicking on the file name can also open an event file.

Only one SEED or PEPP volume set file can be opened. You will receive an error if you try to display the contents of more
then one volume set or if you select an event file and a volume set file.

Directory Dialog Box
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This dialog box is used to change or create a new directory.

Directory Text:

Displays currently selected directory.

Directory List Box:

Displays a list of directories based on the currently selected drive (see below). To select a directory, double click on one
of the directory names.

Drives Select Box:

Used to select the disk drive used by the Directory List box.

OK Button:

Close dialog box and use directory.

Cancel Button:

Close dialog box without using directory.

Help Button:

Opens this documentation.

New Button:

Used to create a new directory. See New Directory dialog box for more information. This button maybe dimmed for
some program functions.

Save as Default Check Box:

When checked, the selected directory will be used as the default directory for new program functions and when
WinQuake is first started. This Check box maybe dimmed for some program functions.

New Directory Dialog Box
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This dialog box is used to create a new directory.

New Directory Path Edit Box:

Enter the directory name to create.

OK Button:

Close dialog box and create new directory.

Cancel Button:

Close dialog box without creating directory.

Help Button:

Opens this documentation.

WinSDR / SDR Replay Dialog Box

This dialog box is used to create and display an event file by using WinSDR or SDR (Seismic Data Recorder) Replay feature over a
Local Area Network.

Start Time Month / Day / Year / Hour/ Minute Edit Boxes:
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Enter the event file start time.

Start Time Select Box:

Select UTC or Local Time for the event file start time.

Event Report Button:

Opens the Event Report dialog box so that a event report time can be used for the event file start time.

Event Time Button:

Enters the currently selected event report time, minus two minutes, in the Start Time Edit boxes. This button will be
dimmed if no event report is currently selected.

Event Report Time Text:

Displays the currently selected event report time.

Length Edit Box:

Enter the Length, in minutes, of the event file.

Channel Select Box:

Select one or more channels to Replay. 

Compression Edit Box:

Used to compress the size of the event file by reducing the sample rate. A Save Nth value of one saves every data point.
A value of two saves every other data point reducing the file size by 1/2 and lowering the sample rate by 1/2. A value of
three saves very third data point etc.

SDR 2.X Mode:

Checked this box if you are using SDR version 2.x.

Save as Default Check Box:

If checked, saves the Length, WinSDR or SDR Channel, and Compression settings to the WinQuake INI file. These
settings will be used as the default settings when the Replay dialog box is used again.

Replay Button:

Start WinSDR / SDR Replay to create an event file. If successful, the dialog box will close and a new event window
will be opened with the newly created event file.

Settings Button:

Opens the Replay Settings dialog box.

Close Button:

Close the dialog box.

Help Button:

Opens this documentation.

Replay Settings Dialog Box
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This dialog box is used to control the settings needed for the WinSDR or SDR Replay feature.

WinSDR / WinQuake Event File Directory Group

WinQuake Directory Text:

Displays currently selected drive and directory where WinSDR or SDR will place event files.

Change Button:

Opens the Directory dialog box. Used to select the drive and directory where WinSDR or SDR will place event
files.

WinSDR Mapped Drive Edit Box:

Enter the mapped drive letter used by the WinSDR or SDR system to share files on your main Windows system.
See the SDR documentation on how to setup SDR to work over a Local Area Network.

WinSDR / WinQuake Request Channel Information Group

Channel Information List Box:

Displays the the current channel information.

Add Button:

Opens the Replay Channel Information dialog box. Replay Channel information entered in the dialog box will be
added to the WinSDR / WinQuake Request Channel Information list box.

Edit Button:

Uses the Replay Channel Information dialog box to edit the currently selected item in the WinSDR / WinQuake
Request Channel Information list box.

Remove Button:

Removes the currently selected item in the WinSDR / WinQuake Request Channel Information list box.

OK Button:

Close dialog box using the new settings.
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Cancel Button:

Close dialog box without using any new settings.

Help Button:

Opens this documentation.

Additional Information:
Settings are saved in the file REPLAY.DAT.

Replay Channel Information Dialog Box

This dialog box is used to add or modify WinSDR or SDR event file request channel information.

Event File Extension Edit Box:

Enter the 2 to 6 (3 maximum for SDR) letter channel Event File Extension identifier.

System Number Edit Box:

Enter the WinSDR or SDR System Number. This setting should be set to "1" if you have one WinSDR or SDR system.
Range: 1 to 10

WinQuake Request Directory Change Button:

Opens the Directory dialog box. Used to select or create a directory that will be used for request file sharing between
WinQuake and WinSDR or SDR.

WinSDR Mode:

Check this check box if you are using WinSDR.

OK Button:

Close dialog box and use new channel information.

Cancel Button:

Close dialog box without using channel information.

Help Button:

Opens this documentation.

Send E-Mail Message Dialog Box
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This dialog box is used to send up to 4 event files, or SEED/PEPP data volume sets, in an E-Mail message. The files are sent as a
MIME attachment. This feature can be used to send event files to the PSN Event Archive system at
eventNOSPAM(at)seismicnet.com.invalid or eventNOSPAM(at)webtronics.com.invalid.

Send To Edit Box:

Enter one or more E-Mail addresses to send the file(s) to. E-Mail addresses should be separated by a comma. This
string is saved in the EMAIL.DAT file

Input Example: eventNOSPAM(at)seismicnet.com.invalid, John Smith
<jsmithNOSAPM(at)somehost.com.invalid>

SMTP Host Edit Box:

Holds your Internet Service Provider's SMTP host name. This string is saved in the EMAIL.DAT file.

Input Example: mail.myisp.com

SMTP Authentication Button:

Opens the SMTP Authentication dialog box. Some ISP require user authentication to use their SMTP server. If 
authentication is required, use the SMTP Authentication dialog box to specify the authentication type, user name and
password. Authentication information is saved in the EMAIL.DAT file.

Your Real Name Edit Box:

Enter your real name. This string is used as part of the From: field of your message and the default Subject: line. This
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string is saved in the EMAIL.DAT file.

Your E-Mail Address or POP Account Edit Box:

Enter your return E-Mail address. Some SMTP Host servers may require that this address be the same as your POP
account address. This string is saved in the EMAIL.DAT file.

Input Example: someone@ahost.com

SMTP Host Edit Box:

Holds your Internet Service Provider's SMTP host name. This string is saved in the EMAIL.DAT file.

Input Example: mail.netcom.com

Subject Edit Box:

Subject line of the E-Mail message.

Text Message Edit Box:

Enter text to send with the E-Mail message. This is optional.

Attached Files Text:

Displays the file name(s), and file size in bytes, that will be sent in the E-Mail message.

Send Button:

Send file(s) using E-Mail message.

Cancel Button:

Close dialog box without sending file(s).

Help Button:

Opens this documentation.

DC Offset Dialog Box

This dialog box is used to compensate for any DC offset in the data set by applying an offset to the data displayed in an event
window.

Current Edit Box:

Changes the current DC offset value used when displaying the current event file. If the data set has an average DC
offset of 30 then a value of -30 will re-center the display around zero. Range: +/- 32,000

Data Average Text:

Displays the average of the data set.

Auto DC Offset Check Box:

When checked, WinQuake will apply the DC offset needed to center a data set around zero when the event file is first
opened or when changes are made to the data set. This setting is saved in the WinQuake INI file.
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OK Button:

Close dialog box and use new settings.

Cancel Button:

Close dialog box without using new settings.

Help Button:

Opens this documentation.

Great Circle Distance Calculator Dialog Box

This dialog box is used to calculate the distance and azimuth between two points on the earth.

Event Latitude Edit Box:

Enter event latitude. Range: +/-90.0, 0 to 90.0N or 0 to 90.0S

Event Longitude Edit Box:

Enter event longitude. Range: +/-180.0, 0 to 180.0E or 0 to 180.0W

Station Latitude Edit Box:

Enter station latitude. Range: +/-90.0, 0 to 90.0N or 0 to 90.0S

Station Longitude Edit Box:

Enter station longitude. Range: +/-180.0, 0 to 180.0E or 0 to 180.0W

Calculate Button:

Calculate distance and azimuth.

Close Button:

Close dialog box.

Help Button:

Opens this documentation.

Additional Information:
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The data under each of the edit boxes displays the latitude or longitude in the degree:minute:second format.

The latitude can be entered as a plus or minus number or end with an N or S. A positive number, or the N character, represents
the Northern Hemisphere and a negative number, or S character, the Southern. The latitude can be entered in either degrees
and a fraction of degree (DD.FFF) or in degree, minute, second and fraction of a second (DD:MM:SS.FFF).

The longitude can be entered as a plus or minus number or end with an E or W. A positive number, or the E character,
represents the Eastern Hemisphere and a negative number, or W character, the Western. The latitude can be entered in either
degrees and a fraction of degree (DDD.FFF) or in degree, minute, second and fraction of a second (DDD:MM:SS.FFF).

Event Information Dialog Box

This dialog box is used to modify or add event information to the event file. More then one event can be entered by using the New
button. 

Event Information Group:

Comment Edit Box:

Enter the event comment string here.

Time Edit Box:

Enter the event start time here. The time is entered in this format: MO/DD/YY HH:MM:SS.T where MO =
Month, DD = Day, YY = Year, HH = hours, MM = minutes, and SS.S = seconds.

Latitude Edit Box:

Enter the event latitude here. See below on entering latitude numbers.

Longitude Edit Box:

Enter event longitude. See below on entering longitude numbers.
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Magnitude Edit Boxes:

Enter the magnitude of the event in one or more of the edit boxes.

Depth Edit Box:

Enter event depth in kilometers.

Agency Edit Box:

Enter the reporting agency in this edit box. Example: NEIC

Event Type Select Box:

Select one of the following event types: Quake, Nuclear, Quarry or Other

Quality Select Box:

Select the event location quality character here. Can be blank or A through E, with A being the best event
location quality.

Event Number Select Box:

Used to select the event that will be displayed, modified or deleted.

New Button:

Saves the current information and clears the fields so that the next event can be entered.

Delete Button:

Deletes the current event information.

Event Report Information Group:

Event Report Text Box:

Displays the current event report. Use the Event Report dialog box to select an event report.

Add Button:

Adds the event report information to the event file. This button will be dimmed if no event report is currently
selected. Use the Event Report dialog box to select an event report. This button can be used to add additional
events to the event file. Use the replace button to update the current select event information.

Replace Button:

Used to replace the current selected event information with new report information.

Make Button:

Makes a event report based on the event information entered above. This button will be enabled when there is
valid event latitude, longitude and time information.

Modify Comment Check Box:
Used when the Add Event Report feature is used. If checked, the comment will be modify with a standard
comment string based on the event and station information.

OK Button:

Close dialog box and use new information.

Cancel Button:

Close dialog box without using new information.

Help Button:

Opens this documentation.

Additional Information:
The text under each of the latitude and longitude edit boxes displays the latitude or longitude in the degree:minute:second
format.
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The latitude of the event can be entered as a plus or minus number or end with an N or S. A positive number, or the N
character, represents the Northern Hemisphere and a negative number, or S character, the Southern. The latitude can be
entered in either degrees and a fraction of degree (DD.FFF) or in degree, minute, second and fraction of a second
(DD:MM:SS.FFF).

The longitude of the event can be entered as a plus or minus number or end with an E or W. A positive number, or the E
character, represents the Eastern Hemisphere and a negative number, or W character, the Western. The latitude can be entered
in either degrees and a fraction of degree (DDD.FFF) or in degree, minute, second and fraction of a second
(DDD:MM:SS.FFF).

Note: The Comment strings will not be saved if the event file is saved as an SAC Binary file.

Sensor Information Dialog Box

This dialog box is used to add or modify information about the sensor used to record the event. Normally this information is add to
the event file by the datalogger.

Latitude Edit Box:

Enter sensor latitude. See below on entering latitude numbers.

Longitude Edit Box:

Enter sensor longitude. See below on entering longitude numbers.

Elevation Edit Box:

Elevation of the sensor in meters above or below (negative number) sea level. Leave blank if unknown.

Orientation Select Box:

Set to Z for a vertical sensor, N-S for a North-South oriented sensor, E-W for a East-West sensor or ? if unknown.

Incident Edit Box:

Sensor incident angle in degrees with respect to vertical. For a N-S or E-W sensor use 90. For a vertical sensor use 0.
Leave blank if unknown.

Azimuth Edit Box:
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Sensor azimuth angle in degrees with respect to the north through east. For a N-S or vertical sensor use 0. For a E-W
sensor use 90. Leave blank if unknown.

Sensor Location Edit Box:

The sensor location string. Example: Redwood City, CA USA

Sensor Description Edit Box:

The sensor information string. Example: 12 Second Lehman or Geospace HS10 1Hz Geophone

Sensor Type Select Box:

Select the sensor output type to either Acceleration, Velocity, Displacement or Unknown.

Sensitivity:

The sensitivity of the sensor if known. See below for more information.

Sensor ID:

The sensor ID string and event file extension from this channel. The sensor ID string should be 3 to 6 characters long.

Component Name:

The sensor component name used to describe the sensor. Example: BHZ or SHN

Network Affiliation:

The sensor's network affiliation. Example: PSN

WinQuake Ml & Ms Correction:

Enter the correction number used for Ml and Ms magnitude calculation.

A/D Bits Edit Box:

Enter the number of A/D converter bits.

Datalogger Text:

Displays the datalogger program name and version number.

OK Button:

Close dialog box and update sensor information in the event file.

Cancel Button:

Close the dialog box without making any changes to the event file.

Help Button:

Opens this documentation.

Additional Information:

The latitude of the sensor can be entered as a plus or minus number or end with an N or S. A positive number, or the N
character, represents the Northern Hemisphere and a negative number, or S character, the Southern. The latitude can be
entered in either degrees and a fraction of degree (DD.FFF) or in degree, minute, second and fraction of a second
(DD:MM:SS.FFF).

The longitude of the sensor can be entered as a plus or minus number or end with an E or W. A positive number, or the E
character, represents the Eastern Hemisphere and a negative number, or W character, the Western. The latitude can be entered
in either degrees and a fraction of degree (DDD.FFF) or in degree, minute, second and fraction of a second
(DDD:MM:SS.FFF).

The Sensor Sensitivity field number depends on the Sensor Output Type field. If the sensor output is acceleration, sensitivity
is in cm/sec/sec per A/D bit, if the output is velocity cm/sec per bit and if the output is displacement in cm per bit. This web
page can be used to calculate the sensitivity number if you know the output voltage level of your sensor.

WinQuake Dialog Box Help

http://www.seismicnet.com/wqdocs/dlghelp.html (15 of 38) [7/18/2008 6:00:37 PM]

http://www.seismicnet.com/calcsens.html
http://www.seismicnet.com/calcsens.html


Data Operations Dialog Box

This dialog box is used to display information on what filters have been applied to the data set and if the data set has been integrated.

Close Button:

Close dialog box.

Help Button:

Opens this documentation.

Additional Information:

The filter abbreviations are:

IIR Filter = Time domain filter using a IIR (Infinite Impulse Response) digital filter
FFT Filter = Filtering using the FFT window
BW = Butterworth filter
HP = Highpass filter
LP = Lowpass filter
Freq: = Filter cutoff frequency
Poles: = Filter poles or how quickly the filter attenuates the signal

STA/LTA Ratio Dialog Box
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This dialog box is used to display STA (Short Term Averaging) / LTA (Long Term Averaging) ratio information of the current
selected event window. This information can be used to help set the event trigger information in WinSDR or SDR. Please see the
STA/LTA WinSDR documentation for more information on STA/LTA event triggering. This dialog box is modeless, meaning that
you can do other things within WinQuake while this dialog box is open.

STA Time Edit Box:

Enter the Short Term Average time in seconds. Fractions of a second may be entered.

LTA Time Edit Box:

Enter the Long Term Average time in seconds. Fractions of a second may be entered.

Ratio Filter:

The Ratio Display list box will only display ratios above or equal to this number.

Ratio Display List Box:

Displays the STA/LTA time and ratio average information.

Calculate Button:

Starts the STA/LTA calculation.

Save File Button:

Saves the data to a file.

Help Button:

Opens this documentation.

Close Button:

Closes the dialog box.

Maximum Ratio Text:

Displays the maximum STA/LTA ratio and the time the ratio was calculated.
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Phase Control Dialog Box

This dialog box controls what additional phases will be displayed when the Display Phases feature is enabled. WinQuake maintains
two sets of additional phase names, one is for the JB travel-time tables and the other is for the IASP91 tables. The IASP91 Phases
check box is used to switch between the two sets of names.

Selected Phases File Text:

Displays the currently selected phase name that will be deleted if the Remove button is used.

Selected Phases List Box:

Displays the list of phase names that will be displayed when the Display Phases feature is enabled.

Remove Button:

Used to remove a Selected Phases: item from the list box.

Select From File Text:

Displays the currently selected phase name that will be added to the Selected Phases list box when the Add is used.

Select From List Box:

Displays the list of phase names that can be added to the Selected Phase list box.

Add Button:

Used to add the currently selected Select From: List box item to the Selected Phases: list box.

IASP91 Phases:

Used to switch between the JB and IASP91 travel-time table display names.

JB Tables Directory Text:

Displays the directory name that holds the JB travel-time table files used by WinQuake. Use the File/Tables Directory
menu item to change the directory used to hold the travel-time table files.
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OK Button:

Close dialog box and use Phases displayed in the Selected Phases List box. Selected Phases are saved in the
PHASES.DAT file.

Cancel Button:

Close dialog box without using, or saving, new list of Display Phases.

Help Button:

Opens this documentation.

Phase Times Display Dialog Box

This dialog box displays the time of origin of the event, based on the location of the P and S markers, and the different phase times.
Additional phases can be displayed by adding them to the Selected Phases list box in the Phase Control dialog box. The third
column is the time difference in seconds between the origin time and the phase arrival time. This dialog box is modeless, meaning
that you can do other things within WinQuake while this dialog box is open. As an example, if you move the P or S markers the
values in this dialog box will be updated with the new phase information. 

Close Button:

Closes the dialog box.

Help Button:

Opens this documentation.

Print Settings Dialog Box
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This dialog box is used to control various printing options.

Margins Group:

Top Edit Box:

Enter the top margin. Range: 0 to 400 pixels

Left Edit Box:

Enter the left margin. Range: 0 to 400 pixels

Button Edit Box:

Enter the bottom margin. Range: 0 to 400 pixels

Right Edit Box:

Enter the right margin. Range: 0 to 400 pixels

Modes Group:

B/W and Color Radio Buttons:

Controls if the printing will be in black and white or color.

Portrait and Landscape Radio Buttons:

Controls how the image is positioned on the page.

OK Button:

Close dialog box and use the new print settings. New settings are saved in the WinQuake INI file.

Cancel Button:

Close dialog box without using or saving new print settings.

Help Button:

Opens this documentation.

RMS / Max / Min Display Dialog Box
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This dialog box is used to display the RMS (Root Means Square), maximum and minimum values of the event window. The data
can be displayed in A/D counts or if known sensor units. The RMS and other values are calculated using the data in the current
window view area. This dialog box is modeless, meaning that you can do other things within WinQuake while this dialog box is
open. Whenever the X-Scale changes or the window start time changes, the program will recalculate the values based on the new
start time or window time length.

Display A/D Counts Check Box:

Displays the values in A/D counts.

Sensor Units Check Box:

Displays the values in sensor units of acceleration, velocity or displacement depending on the sensor type. This check
box will be disabled if the sensor output type or sensitivity fields of the event file header are not specified.

Close Button:

Closes the dialog box.

Help Button:

Opens this documentation.

Event Report Dialog Box
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Used to select a event report. The event report contains information about the earthquake, like location and magnitude, that can be
added to the event window and saved in the event file. See Using the Event Report Feature documentation for more information.

Event Report File Text:

Displays the current event report file. Use Load Report File or Load Network Report to load a new file.

Distance to Station Text:

Displays the distance in km and miles between the station and the currently selected event in the List box.

Report Type Select Box:

Shows a list of event report types that WinQuake supports. WinQuake will try to select the proper type based on the
information within the event report. You may need to select the event report type if WinQuake can not find the
keywords used to automatically select the type.

Report List Box:

Displays the list of events that can be selected for the new event report. Double clicking on an event will add the event
report to the current event window and close the dialog box. This is the same thing as pressing the Add Report and then
the OK button.

Up / Down Control:

Used to control the direction, either newer events on top or bottom, of the list box.

Load Report File Button:

Opens the Report Open File dialog box. Use this dialog box to select a new event report file. If WinQuake knows the
format of the report file, the list box will display the list of events.

Network Report Button:

Opens the Network Event Report dialog box. Using this dialog box an event report file or Web page can be downloaded
over the Internet using the Web, FTP or finger services. After downloading the event report file, the List box will
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display the new list of events.

Historical Lookup Button:

Opens the Network Event Report dialog box. Only the historical servers will be displayed in the Network Service list
box. See the Historical Data Lookup dialog box for more information. 

Save on Clipboard Check Box:
If checked, the event report will be placed on the system's clipboard as a text message. This information can be used to
transfer the event information to other programs like WinSDR.

Search Button:

Search for an event report in the list box. The search time used is the event file start time. If the search fails, you should
manually search for the event in the list box.

Add / Replace Report Button:

Adds or replaces the currently selected event report to the event file.

OK Button:

Close dialog box and use new event report information.

Cancel Button:

Close dialog box without using new event report information.

Help Button:

Opens this documentation.

Additional Information:

WinQuake requires that the REPORT.DAT file be located in the same directory as the executable (winqk32.exe) for this
feature to work. This file contains information on how to parse the event report information.

Network Event Report Dialog Box
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Used to download event report information over the Internet.

Network Service Group:

List Box:

Displays the list of event report services available on the Internet that WinQuake supports. Event reports can be
download by selecting the service in the List box and then Connect. Double clicking on the service name will
also start the download.

Add Button:

Opens the Add Network Report Service dialog box. This dialog box is used to add a Web page, FTP address or
Finger command to the list of event report services.

Del Button:

Used to delete the currently selected event report service in the List box.

Save Button:

Used to save the new list of event report services to the NETWORK.DAT file.

Historical Button:

Opens the Historical Data Lookup dialog box. This button will be enabled if one of the historical event database
services is selected. Historical service names start with data@.  

Connection Information Group:

Status Text:

Displays the status of the download. Any download or connection errors will be displayed here.
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Bytes Received Text:

Displays the number of bytes received as the file is being downloaded.

File Information Group:

Name Text:

Displays the file name of the event report.

Directory Text:

Displays the directory where the event report file will be placed after the download.

Directory Button:

Opens the change Directory dialog box. This dialog box is used to select a directory where the event report file will be
placed after the download.

Connect Button:

Start the event report file download. If the download is successful, the dialog box will be closed and the event report
dialog box will use the new event report.

Close Button:

Close dialog box.

Help Button:

Opens this documentation.

Additional Information:

The lists of services are saved in a file called NETWORK.DAT. This file must be located in the same directory as the program
executable (winqk32.exe).

Historical Data Lookup Dialog Box

The Historical Data Lookup dialog box is used to enter the start and end dates for the historical database lookup request and to
specify a magnitude filter.
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Start Date Edit Boxes:

Enter the request start date.

End Date Edit Boxes:

Enter the request end date.

Magnitude Edit Boxes:
You can filter the event data sent back from the server my entering different magnitude numbers in the edit boxes. The
Maximum filter will be disabled when the data@seismic.geol.binghamton.edu server is used to retrieve event report
information.

Connect Button:
Press this button to start the event database lookup. When the downloading of the data is completed, the event list will
be displayed in the Event Report dialog box. Use the Cancel button in the Network Report dialog box to stop the data
download.

Cancel Button:
Closes the dialog box without accessing the database.

Help Button:
Opens this documentation.

Additional Information:

This dialog box is opened from the Network Report dialog box when you press the Historical button. This button will be
enabled if one of the historical servers is selected in the Network Service list box. Historical servers start with data@... If you
use the Historical button in the Event Report dialog box, the Network Services list box in the Network Report dialog box will
only list historical services.

Currently there are two historical servers available on the internet that can be used with WinQuake. The PSN server can be
accessed using this service: data@quake.seismicnet.com and the backup server at data@psn.webtronics.com. This database of
events covers the period 1979 to present. Event data is retrieved once a day, at midnight local time, from the CNSS composite
database. See this page for more information http://quake.geo.berkeley.edu/cnss/cnss-catalog.html. Only events larger then or
equal to 2.5 are saved in the PSN database.

The other database can be accessed using data@seismic.geol.binghamton.edu. This database covers the period 7/1999 to
present and lists events equal too and larger then 3.0. This database is used by Alan Jones's Seismic-Eruptions program. See
http://www.geol.binghamton.edu/faculty/jones/jones.html for more information on Alan's excellent Seismic-Eruptions and
Seismic-Waves programs.

Add Network Report Service Dialog Box

Used to add a new Internet Event Report service URL.

New Network Event Report Service Edit Box:

New Web page address (URL), FTP location, finger command or historical server. An optional comment can be added
after the service location.
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OK Button:

Close dialog box and add new event report service.

Cancel Button:

Close dialog box without adding new event report service.

Help Button:

Opens this documentation.

Additional Information:

Event report services can be an Internet Web page address in the format http://location/document, FTP location in the format
ftp://location/document, or finger command in the format name@domain.name.

Examples:

Web Page Address:

http://www-socal.wr.usgs.gov/given/review/hyp.list (So. Cal Events)

Note: The "(So. Cal Events)" part of the string is the optional comment.

FTP Location:

ftp://quake.usgs.gov/newlist.dat (Northern Cal List)

Finger Command:

quake@gldfs.cr.usgs (World-Wide)

Save File Dialog Box
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Used to save event files in PSN Binary Type 4, PSN Binary Type 3, PSN Text or SAC Binary formats. Event windows can also be
saved as GIF images.

File Name Edit Box:

File name and directory that will be used when saving an event file data set or GIF image file.

Long Name Button:

Convertes a 8.3 format file name, example 020403A.LC1, to the long file name format. See the Long File Name check
box for more information.

Browse Button:

Opens the Windows Save As dialog box. This dialog box can be used to select a name and / or directory that will be
used to save the event file data or GIF image.

Save Options Group:

Save Every Nth Data Point Edit Box:

Used to compress the size of the event file by reducing the sample rate. A value of one saves every data point. A
value of two saves every other data point reducing the file size by 1/2 and lowering the sample rate by 1/2. A
value of three saves very third data point etc. Input Range: 1 to 1000

Y-Compression Edit Box:

Used when saving PSN Type 4, SAC or Seed volume data to a PSN Type 3 binary file. This is needed because
PSN Type 4, SAC or Seed files use floating point or long 32-bit integers numbers that can be larger then allowed
in the PSN Type 3 binary format. WinQuake will calculate a divide number based on the data set. This number
can be overwritten by using the edit box.

View Only Check Box:

If not checked, save entire data set. If checked, only save the part of the data set being viewed. This check box
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control is dimmed when the entire data set is being viewed.

Invert Data Check Box:

If checked, data will be inverted as it is being saved.

DC Offset Check Box:

If checked, WinQuake will apply the current DC offset to the data when saving the event file. See the DC Offset
dialog box for more information.

Save Data Type Group:
This group will be enabled if the Save Format select box is set to PSN Type 4. It controls how WinQuake will save the
data in the event file.

Auto Check Box:

If checked, WinQuake if pick the best format to use when saving data.

Integer (16 bits) Check Box:

If checked, the data will be saved as 16 bit integers.

Long (32 bits) Check Box:

If checked, the data will be saved as 32 bit longs.

Float (4 bytes) Check Box:

If checked, the data will be saved as IEEE floats.

Double (8 bytes) Check Box:

If checked, the data will be saved as IEEE doubles.

Archive Name Group:

Make Button:

Creates an archive name based on the data set start time. See below for more information.

Directory Button:

Sets the root directory for the Make Archive Name feature. See below for more information.

Long File Name Check Box:

If check, WinQuake will name the file using the long file format. A typical long file name looks like this:
020407.201921.mete.psn. The format is: year-month-day.hour-minute-second.station_id.psn.  

Use Event Time:

If checked, the file name will be based on the event time rather then the start time of the data set. 

GIF Settings Button:

Opens the GIF Settings dialog box.

Overwrite Message Check Box:

If checked, and a file with the same name exists, you will be prompted before overwriting the file.

Save Format Select Box:

Used to select the output file format. Four output formats are currently supported: PSN Type 4, PSN Type 3, PSN Text,
SAC binary and GIF image.

OK Button:

Close dialog box and save file using the selected Save Format and File Name.

Cancel Button:

Close dialog box without saving file.

Help Button:
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Opens this documentation.

Additional Information:

The Archive Name feature of WinQuake is used to normalize event file names and their location on your hard disk. The
Directory button is used to set up a root directory where your event files can be placed. After selecting a root directory (this
only needs to be done once), event files will be placed in the following directory when you select the Make button:

drive:\root_directory\YYMM\

The drive:\root_directory\ part of the name comes from the drive and directory selected using the Directory button. The
\YYMM\ subdirectory is based on the data set start time year and month.

GIF Settings Dialog Box

This dialog box is use to control the size of the GIF image when saving an event window as a GIF file. There is also a check box to
correct color problems with the image created by WinQuake.

Height Edit Box:

Controls the height of the image in pixels. Range: 100 to 2048.

Width Edit Box:

Controls the width of the image in pixels. Range: 100 to 2048.

32k Colors Check Box:

On some systems you may need to check this check box so that the colors of the image match the ones you have chosen
for your seismogram.

OK Button:

Close dialog box and use new settings. Settings are also saved in the WinQuake INI file.

Cancel Button:

Close dialog box without using or saving settings.

Help Button:

Opens this documentation.

Time Information Dialog Box
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This dialog box is used to adjust various time information in the event file. It can be used to adjust the start time, start time offset and
the time reference information in the header section of the event file being displayed.

Adjust Start Time Button:

Opens the Time Correction dialog box. In this dialog box you enter the number of seconds to add or subtract to or from
the start time of the event file. Offset time can also be entered in hour:minute:second format.

Start Time Offset Edit Box:

Used to change the Start Time Offset field in the PSN Type 4 event file header. See the PSN Type 4 documentation for
more information.

Time Reference Select Box:

Used to select or clear the Time Reference type used for datalogger time keeping. Can be one of the following: None,
GPS, WWV, WWVB or Other. 

Reference Status Select Box:

Used to select or clear the time reference status. Can be one of the following: Not Locked, Was Locked or Locked.

OK Button:

Close dialog box and update the event file with the new time information.

Cancel Button:

Close dialog box without updating the event file time information.

Help Button:

Opens this documentation.

Travel-Time Tables Dialog Box
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This dialog box selects which set of P and S wave travel-time table files will be used for regional or local events, and teleseismic or
distant events. It also selects which set of tables, either regional,  teleseismic JB tables or the IASP91 set of travel-time tables, to use
with the event file being displayed. See How WinQuake Calculates Distance for more information.

Regional Group:

P Wave File Text:

Displays currently selected regional P wave travel-time file name.

P Wave File Change Button:

Opens the Change P or S Wave File dialog box. This dialog box is used to select a new P wave file.

S Wave File Text:

Displays currently selected regional S wave travel-time file name.

S Wave File Change Button:

Opens the Change P or S Wave File dialog box. This dialog box is used to select a new S wave file.

Max Distance Text:

Displays the maximum distance supported by the currently selected P and S wave tables.

Teleseismic Group:

P Wave File Text:

Displays currently selected teleseismic P wave travel-time file name.

P Wave File Change Button:

Opens the Change P or S Wave File dialog box. This dialog box is used to select a new P wave file.

S Wave File Text:

Displays currently selected teleseismic S wave travel-time file name.

S Wave File Change Button:

Opens the Change P or S Wave File dialog box. This dialog box is used to select a new S wave file.
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Max Distance Text:

Displays the maximum distance supported by the currently selected P and S wave tables.

Depth Edit Box and Slide Control:

This edit box and slide control change the depth that will be used for travel-time calculation.

Current Table Group:

Regional Check Box:

If checked, the currently displayed event file window will use the regional tables for distance calculation.

Teleseismic Check Box:

If checked, the currently displayed event file window will use the teleseismic tables for distance calculation.

IASP91 Check Box:

If checked, the currently displayed event file window will use the IASP91 tables for distance calculation.

All Event Files Windows Check Box:

If checked, all event windows will be changed to the new settings.

Save as Default Check Box:

If checked, the P and S wave file names and the status of the Current radio buttons will be saved to the WinQuake INI
file.

Update P & S Location Check Box:

If checked, the P and S markers location will be updated using the new table information.

OK Button:

Close dialog box and use new Travel-Time Table settings.

Cancel Button:

Close dialog box without using new Travel-Time Table settings.

Help Button:

Opens this documentation.

New P or S Wave File Dialog Box

This dialog box is used by the Travel-Time Tables dialog box to select either a P or S wave travel-time table file.
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File Name Text:

Displays currently selected travel-time file.

File Name List Box:

Used to select new travel-time table file.

OK Button:

Close dialog box and use new travel-time file.

Cancel Button:

Close dialog box without using file.

Help Button:

Opens this documentation.

X-Scale Dialog Box

Used to control the X, or time, scale of the event window. By changing the X-Scale you can zoom in or out within the data set.
Zoom in can also be done with the mouse.

Edit Box:

Enter the new X-Scale in seconds. Range: 1 to the total number of seconds of the event file.

Scroll Bar:

This control can be used to change the X-Scale number in the Edit box.

All Event Windows Check Box:

When checked, the X-Scale in the Edit box will be applied to all event windows. This control will be dimmed if only
one event window is being displayed.

OK Button:

Close dialog box and use new X-Scale.

Cancel Button:

Close dialog box without using new X-Scale.

Help Button:

Opens this documentation.

Y-Scale Dialog Box
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This dialog box is used to control the Y-Scale, or data amplitude, of the event window. it is also used to control how WinQuake
displays the amplitude data on the left hand side of the event window. A negative Y-Scale number compresses the data set and a
positive number expands the data set.

Edit Box:

Enter the new Y-Scale value.

Scroll Bar:

This control can be used to change the Y-Scale number in the Edit box.

OK Button:

Close dialog box and use new Y-Scale.

Cancel Button:

Close dialog box without using new Y-Scale.

Help Button:

Opens this documentation.

Time Domain Filter
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This dialog box is used to control filtering of the data set in the time domain. The filter applied is a Infinite Impulse Response low or
high pass Butterworth filter.

Low-Pass Check Box:

If checked, a low-pass filter will be applied to the data set.

Low-Pass Cutoff Freq Edit Box:

Enter the low-pass filter cutoff frequency.

Low-Pass Poles Select Box:

Select the number of poles that will be used when filtering the data set. The number of poles controls the slope of the
filter.

High-Pass Check Box:

If checked, a high-pass filter will be applied to the data set.

High-Pass Cutoff Freq Edit Box:

Enter the high-pass filter cutoff frequency.

High-Pass Poles Select Box:

Select the number of poles that will be used when filtering the data set. The number of poles controls the slope of the
filter.

Save as default Check Box:

If checked, the entries in the various fields will be saved as the default values. This values will be displayed when the
dialog box is first opened.

Apply Now Button:

Applies the high or low pass filter to the data set.

Undo Filter Button:

Undoes the last filter applied to the data set.

Close Button:

Closes the dialog box.

Help Button:

Opens this documentation.

Low-Pass or High-Pass Filter Dialog Box

Used by the FFT (frequency spectrum) window to filter the event data set with either a Low-Pass or High-Pass filter. Filtering can
be used to remove unwanted noise in the seismogram.

Cutoff Freq Edit Box:

Enter the filter cutoff frequency.
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Poles Edit Box:

Enter the number of poles that will be used when filtering the data set. The number of poles controls the slope of the
filter.

Save as Default Check Box:

If checked, the cutoff frequency and number of poles will be used as the default value for either the Low-Pass or
High-Pass Filter. These settings are saved in the WinQuake INI file.

OK Button:

Close dialog box and apply the filter to the data set.

Cancel Button:

Close dialog box without filtering the data set.

Help Button:

Opens this documentation.

Bandpass or Notch Filter Dialog Box

Used by the FFT (frequency spectrum) window to filter the event data set with either a Bandpass or Notch filter. Filtering can be
used to remove unwanted noise in the seismogram.

High-Pass Cutoff Freq Edit Box:

Enter the High-Pass cutoff frequency.

Low-Pass Cutoff Freq Edit Box:

Enter the Low-Pass cutoff frequency.

Poles Edit Box:

Enter the number of poles that will be used when filtering the data set. The number of poles controls the slope of the
filter.

Save as Default Check Box:

If checked, the Low-Pass or High-Pass cutoff frequencies and number of poles will be used as the default value for
either the Notch or Bandpass Filter. These settings are saved in the WinQuake INI file.

OK Button:

Close dialog box and apply the filter to the data set.

Cancel Button:

Close dialog box without filtering the data set.

Help Button:

Opens this documentation.
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Register Software Dialog Box

This dialog box is used to register your copy of WinQuake. Please see register.txt for more information on registering your copy of
WinQuake.

Registration Status:

Displays the current registration status.

Registration Name Edit Box:

When you register your copy of WinQuake you will be given a name and code. Place the name in this edit box. Make
sure that you do not have any leading or trailing spaces and that all upper and lower case characters are correct.

Registration Code Edit box:

Place your registration code in this edit box. Make user you only enter six numbers in this field.

Register Button:

After entering your name and code press this button. If you get an error message make sure you entered the correct
name and code.

Registration Information Button:

Displays the register.txt file.

Close Button:

Close dialog box.

Help Button:

Opens this documentation.
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How WinQuake Calculates Distance

Contents:
Introduction●   

Travel-Time Tables●   

Calculating Distance●   

Additional Information●   

Introduction:
WinQuake maintains three sets of P and S wave travel-time tables. Two are Jeffreys-Bullen (JB)
tables, one set for teleseismic (distant events) and the other for regional or local events. The third
set of tables use the IASP91 model of the earth. These tables are used to calculate the distance and
the time of origin of the event. They are also used to calculate the location of the P and S markers
if the event time and location are known.

Travel-Times Tables:
To change the travel-time table information, use the Tables menu item to open the Travel-Time
Tables dialog box. This dialog box is used to select which set of tables (JB regional, JB teleseismic
or IASP91), the depth, and what JB travel-time files to use for regional or teleseismic calculation.

When changing JB travel-time table files you must select files that are compatible with each other.
The teleseismic or regional P and S wave travel-time table files must have the same distance and
depth sequence. You will receive an error when you close the dialog box if one of the files is
incompatible with the other. Normally you would leave the P and S teleseismic table files at P.jb
and S.jb.

The regional JB travel-time tables shipped with WinQuake are Pn, Sn (P_n.jb and S_n.jb files),
Pg, Sg and Pb, Sb. I have found that the Pb and Sb (P_b.jb and S_b.jb) files work best for events
here in the San Francisco Bay Area.

When you see the "Table Out Of Range" message on the line that shows distance and magnitude in
the event window, you are either viewing an event that is to far or to close for the travel-time table
type and depth currently selected. An event can be to close for a table if you have a very deep
depth selected and you are trying to calculate the distance of a shallow event. If you do not know
the depth of an event, you should use the depth at 33km for teleseismic tables and 5km for regional
tables (if the normal events for the region are shallow like in the San Francisco Bay Area).
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Calculating Distance:
WinQuake calculates the distance between the station and the event using P and S markers. The
user places these markers at the arrival times of the two waves. The distance is then calculated
using the time difference between the two markers and the currently selected travel-time table and
depth.

Learning to pick the P and S wave arrival times will take some practice. One way of learning how
to pick the P and S waves is using the P-S Location feature of WinQuake. To activate this feature,
us the "LOC" toolbar icon or the Calculate menu item. To use this feature you will need an event
file with a known event location and time of origin. When this feature is activated, WinQuake will
places the P and S markers at the calculated arrival times using the currently selected travel-time
tables and depth.

Additional Information:
The JB travel-time files used by WinQuake are installed by the setup program in a sub-directory
called TABLES. This sub-directory is located in the directory where WinQuake is installed in. You
can change the location of the tables directory by using the Tables Directory item under the File
menu item. The travel-time table files must have a file extension of *.JB. The IASP91 tables are in
one large file named IASP91.DAT. This file must be in the same directory as the WinQuake exe
file (winqk32.exe) and not located the in the directory used for the JB tables.
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How WinQuake Calculates Magnitude

Contents:
Introduction●   

ML Calculation●   

Ms Calculation●   

ML and Ms Magnitude Marker●   

Md Calculation●   

Magnitude Correction Factor●   

Setting the Magnitude Correction Factor Number●   

Introduction:
WinQuake can calculate the magnitude of an event using several different methods:

ML Calculation:
The program calculates the ML, or the Richter magnitude, using the distance between the station
and the event, the min/max data points, a correction factor for the seismometer, and a lookup table.
The lookup table, an ASCII file called MAGTBL.DAT that must be located in the same directory
as the WinQuake exe file, is used to correct the magnitude number based on the distance. I have
extended this table out to the maximum P and S wave distance calculation of ~12,000km. The
table above 600km is purely experimental. I used several teleseismic events received on my long
period Lehman sensor and plotted out the correction factor needed to extend the table. I have
received many teleseismic events since extending the table, and so far, most have been within
+-0.3 ML. The table from 0 to 600km was copied from C. F. Richter's "Elementary Seismology"
book.

Ms Calculation:
Ms, or surface wave magnitude, is similar to the ML calculation except a formula is used in place
of the look up table. The following formula is used:

Ms = log_10(amp/T)+1.66*log_10(dist)+3.3

Where T is the period of the wave used in seconds (default = 20 seconds).
Amplitude is in micrometers (this is derived from the min/max A/D counts and
the magnitude correction factor) and distance in degrees (1 degree =
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~111.1km).

ML and Ms Magnitude Marker:
A magnitude marker can be used to override the min/max number used for ML or Ms calculation.
When this marker is turn on, using the Magnitude Marker (ML & MS) item under the Calculate
menu, the program will use the height of the marker to calculate the magnitude.

Md Magnitude Calculation:
WinQuake can also calculate the magnitude using the Md, sometimes called coda or duration,
method. This method uses the length of the event rather then the maximum amplitude. This type of
magnitude calculation only works for local events.

To calculate the Md of a local event first pick the P and S waves, using the P and S markers, and
then press the Md toolbar icon or select the Md Marker item under the Calculate menu item. The
program will then place a "D" marker on the screen at the coda location. This is where the waves
from the event go back into the background noise. You may need to fine-tune the coda location by
moving the "D" marker.

Magnitude Correction Factor:
The magnitude correction factor number used by the ML, Ms and Mb calculation is used to
compensate for different seismometer sensitivities. The correction number is located in the header
information of PSN event files, or located in a file called MAGCORR.DAT. For SAC, PEPP or
SEED volume files the stations ID can be used to supply a correction factor by using any text
editor and adding the information to the MAGCORR.DAT file.

For EMON (one of two data logging programs used by PSN stations) users, this number can be set
in the EMON.OPT file for EMON Version 6 and up. WinSDR or SDR (the other programs used
for data logging by PSN stations) users can set this number in the channels settings dialog box or
screen.

Setting the Magnitude Correction Factor Number:
The magnitude correction factor for a seismometer is determined by using an event with a known
magnitude. After picking the P and S waves, use the Sensor Information dialog box to enter a
correction number so that the calculated magnitude matches the reported event magnitude.
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WinSDR / SDR and WinQuake Replay
Feature

Contents:
Introduction●   

WinSDR Setup●   

SDR Setup●   

WinQuake Configuration●   

Introduction:
The replay feature allows the user to request an event file using WinQuake and WinSDR or SDR.
To use this feature with SDR you must have your SDR system and your Windows system
(Win3.1, Win95/98 or NT) networked together using two network LAN (Local Area Network)
cards. WinSDR users can run WinQuake on the same system as WinSDR or on a remote system.

WinSDR Setup:
To use this feature using WinSDR you will need to create two directories on either the
WinSDR system or on some other system located on your LAN. WinQuake can be located
anywhere on your network or the WinSDR system. In WinSDR, open the System Settings
dialog box and use the Request Control File Browse button to select the directory where
WinSDR will look for request files from WinQuake. For more information on file sharing
see the SDR Setup documentation below. For more information on using the request event
file feature in WinSDR see this documentation. 

SDR Setup:
First you need to get the two systems networked together. I would suggest loading Win95/98 on
both systems if you are going to use this feature. In the current release of SDR there is a
netwin95.htm file that explains how to do this. Another file you need to read is sdrwin95.htm. This
file explains how to run SDR in the DOS only mode of Win95. If you get the network working
you should be able to map a drive letter, example "D:" on your SDR system so that it is the same
drive as the "C:" (or other local disk) drive on your Windows system. Another words, if you have a
directory named c:\sdr\event\ on your Windows system, and, if you have your SDR system map to
the D: drive to be the same as the C: drive on the other system, then d:\sdr\event\ will be the same
directory, and, files can be shared between the two systems.
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For this feature to work you will need two directories. One will hold the temporary request
information file that SDR reads for the replay information, and the other will hold the returned
event file(s). Create two directories like c:\sdr\event and c:\sdr\request on your Windows system.
Now enter the shared drive and path information in the field "Request Control File Path" under the
F5 settings in SDR. If the SDR D: drive = the C: drive on the Windows system then enter
"d:\sdr\request\" for that menu item. That's all you need to do on the SDR side of things. SDR will
look for a request file in that request directory every 10 seconds. If it finds one, it tries to do the
replay and create the event file(s).

For more information on how the request process works in SDR, please read request.htm.

WinQuake Configuration:
When WinQuake firsts starts up it looks for a file called REPLAY.DAT in the same directory as
WinQuake runs out of. If it finds it, the new "Replay" button in the File Open dialog box will be
enabled. If the file is not there this button will be disabled. Since this button will be disabled when
you run WinQuake for the same time you will have to use the menu item "Replay Setup" under the
File menu items.

The Replay Settings dialog box is used to create and manage the REPLAY.DAT file. The first
item in this dialog box is the returned event file path that WinSDR or SDR will use to place files
in. Use the "Change" button to select the directory that you will be using, example c:\data\event, to
hold the returned event files. Next you need to add the channel information for each of your
sensors you are running. For each channel select the "Add" button. In the Replay Channel
Information dialog box add the file extension for that channel, like LC1. If you only have one
WinSDR / SDR system keep the System Number at 1. Next set the WinQuake Request Directory to
the directory you will be using for the request control file. Example: c:\sdr\request. This directory
must be available to both WinQuake and WinSDR or SDR. If you are using WinSDR as the
datalogger you must check the WinSDR Mode check box.   

After entering the replay information you should be able to do a replay. The Replay button should
now be enabled in the File Open dialog box. In the Replay dialog box you will see a series of edit
boxes for the start time, save length, channel etc. After filling in the start time and channel press
the "Replay" button. WinQuake will create a request file for WinSDR or SDR to read and then
waits for the event file(s) to be created by the datalogger. If after ~40 seconds there is no event file
found, WinQuake will time out. If it does find the event file it will close out the Replay dialog box
and open the event file(s). The "Report" and "Report Time" can be used to set the starting time
based on the currently selected report time. The Save Default check box is used to save selected
fields, marked with a * in the group box name, as default settings for the next time you run
WinQuake.
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Using the Remote File Request Feature

Contents:
Introduction●   

Dialog Boxes

Remote Event File Request❍   

Remote Station Information❍   

●   

Introduction:
The Remote File Request feature is used to send email request to PSN stations for event files or station
information. The event files, or station information, are returned as email messages from the remote
station(s). WinQuake does not directly receive the event files or station information. The event files or
station information are saved to disk using the users email program like Outlook Express or Eudora and
then loaded by WinQuake. 

Dialog Boxes:
The following dialog boxes are used to control the Remote File Request feature.

Remote Event File Request Dialog Box
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This dialog box is used to send requests for event file(s) or station information to one or more remote
stations.

Start Time Group:
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Start Time Month / Day / Year / Hour/ Minute Edit Boxes:

Enter the event file start time.

Start Time Select Box:

Select UTC or Local Time for the event file start time.

Event Report Button:

Opens the Event Report dialog box so that a event report time can be used for the
event file start time.

Event Time Button:

Enters the currently selected event report time, minus two minutes, in the Start Time
Edit boxes. This button will be dimmed if no event report is currently selected.

Event Report Time Text:

Displays the currently selected event report time.

User Information Group:

Send To Edit Box:

Enter the email addresses that the remote station will used to send the event files or
station information too.

Input Example: jsmith@somehost.com

Your Real Name Edit Box:

Enter your real name. This string is used as part of the From: field of your message.

Email Address or POP Account Edit Box:

Enter your return email address. Some SMTP Host servers may require that this
address be the same as your POP account address.

Input Example: someone@ahost.com

SMTP Host Edit Box:

Enter your ISP's SMTP host name or IP address.

Input Example: mail.myisp.com

Remote Station Group:

List Box:

Use this list box to select one or more remote stations that will receive your event file
or station information request. 

Email Address Display:

Displays the email address of the current selected station.
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Get Station Information Check Box:

If checked, the remote station will respond with information about each of the
stations' sensor channel(s). The returned email message should be saved as a text file
and then loaded using the Load File button in the Remote Station Information dialog
box.

Add Button:

Opens the Remote Station Information dialog box. Used to add a new remote station
and channel information. 

Edit Button:

Opens the Remote Station Information dialog box. Used to modified the information
of a remote station. 

Del Button:

Deletes the current station.

Load Station File Button:

Reads a PSN Station database file to update the Remote Station list box with new
station information. The current PSN database file can be downloaded from here.
After unzipping the database file use the Windows Open File dialog box to locate and
open the file. 

Channel List Box:

This list box displays all of the sensor channels selected in the Station list box. Event files
will be requested for all of the channels selected in this list box.

File Length Edit Box:

Enter the file length in minutes of the event file(s). The actual file length will depend on the
sample rate (SPS):

    200 or 100 SPS = 1 Hour
            50 SPS = 2 Hours
      20 or 25 SPS = 4 Hours
            10 SPS = 8 Hours
             5 SPS = 12 Hours
             1 SPS = 24 Hours

Sample Rate Select Box:

Select the sample rate of the event file(s).

SMTP Authentication Button:

Opens the SMTP Authentication dialog box. Some ISP require user authentication to use
their SMTP server. If  authentication is required, use the SMTP Authentication dialog box to
specify the authentication type, user name and password. Authentication information is
saved in the remote.dat file.
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Send Request Button:

Sends the request the the selected stations.

Close Button:

Closes the dialog box.

Help Button:

Opens this documentation.

 Remote Station Information Dialog Box

This dialog box is used to add or modify remote station information. It is also used to add or modify
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remote station sensor information.

Station Name Edit Box:

Enter the station name in this edit box.

Email Address:

Enter the email address of the remote station in this edit box. Only the email address should
be placed in this field. Example: psnstation@somedomain.com

Channel ID List Box:

This list box displays the sensor channel IDs at the remote station. The Channel Information
edit boxes will display additional information for the selected channel.

Delete Channel Button:

Deletes the current selected channel in the Channel ID list box.

Load File Button:

This button is used to load a station information file. If the users sends a Get Station
Information (see the dialog box above) request, the station will send back a station
information email message. This email message should be saved as a text file and loaded
using the Open File dialog box that is opened when this button is pressed. WinQuake will
read this file and add the channel information contained in the file.

New Id Edit Box and Add Button:

Used to add a new channel ID to the Channel list. After entering the channel ID, and
optional Component, Sensor Location and Sensor Information the user should press the Add
button to add the new information.

Channel Information Group:

These edit boxes are used to add additional information about the sensor channel.

Component Edit Box:

Used to enter or modified the Sensor Component string.

Sensor Location Edit Box:

Used to enter or modified the Sensor Location string.

Sensor Information Edit Box:

Used to enter or modified the Sensor Information string.

Ok Button:

Closes the dialog box. Information added or modified will be used by WinQuake and saved
in the remote.dat file.

Cancel Button:

Closes the dialog box. Information added or modified will not be used by WinQuake.

Help Button:
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Opens this documentation.
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Using the Event Report Feature

Contents:
Introduction●   

Downloading Event Reports●   

Using the Event Report Dialog Box●   

Additional Information●   

Introduction:
The event report processing feature of WinQuake is used to update the event file window with
information about the earthquake. This information includes location, time of origin, and the
magnitude of the event. Event report information can be download using the FINGER, FTP or
Web page services available on the Internet. The USGS and other earthquake reporting services
create the event report information. The event report information will be saved in the PSN or SAC
Binary event file when the updated event file is saved using the Save File dialog box.

WinQuake can also access two historical event databases. For more information see this
documentation.

Downloading:
Event report information can be downloaded in several ways:

WinQuake can directly download several event reports available on the Internet. The Load
Network Report button in the Event Report dialog box can be used to download the following
reports:

FINGER services:

quake@seismo.berkeley.edu (Northern California)❍   

quake@gldfs.cr.usgs.gov (World-Wide)❍   

spyder@dmc.iris.washington.edu (IRIS)❍   

quake@scec.caltech.edu (Southern California)❍   

quake@tako.wr.usgs.gov (Hawaii)❍   

quake@fm.gi.alaska.edu (Alaska)❍   

quake@geophys.washington.edu (Washington State Area)❍   

quake@seismo.unr.edu (Nevada Area)❍   

quake@mbmgsun.mtech.edu (Montana Area)❍   
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quake@eqinfo.seis.utah.edu (Utah Area)❍   

quake@sisyphus.idbsu.edu (Idaho Area)❍   

quake@info.seismo.usbr.gov (Wyoming Area)❍   

quake@quake.eas.slu.edu (Central USA)❍   

quake@ldeo.columbia.edu (Eastern USA)❍   

Web pages:

http://quake.wr.usgs.gov/QUAKES/CURRENT/norcal.list (Northern California Events)❍   

http://www.scecdc.scec.org/recenteqs/Quakes/quakes0.html (Ca & Nevada Events)❍   

http://www-socal.wr.usgs.gov/given/review/hyp.list (Southern California Events)❍   

http://quake.wr.usgs.gov/QUAKES/WEEKREPS/LATEST/index.html (Weekly Northern
Ca)

❍   

FTP locations:

Currently all of the event reports can be downloaded using the FINGER or the Web.❍   

Using the Event Report Dialog Box:
After downloading an event, the Event Report dialog box can be used to load the report
information. When you first load an event report file, or use the Load Network dialog box, the
program will attempt to determine the type of the event report using a keyword string within the
report. If WinQuake is unable to determine the report type, you will need to use the Type: select
box.

WinQuake searches for the event based on the start time of the event file currently being view,
when the event file is first loaded. The search button can also be used to search for the event. Since
several events can be near each other, or the start time of the event file is not within 60 seconds of
an event, you may need to manually select the proper event.

After the report is selected, the Event Information dialog box or the Add Event Report button in the
Open File dialog box, can be used to add the information to the event file. The Make button in the
Modify dialog box can be used to create an event report using information in an event file. This
feature can be used to transfer event report information between event files.

Additional Information:
The REPORT.DAT file must be in the same directory as the WinQuake executable file. This file
contains information used by WinQuake to parse the different event report files.
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Downloading Event Files Using the
Internet

Contents:
Public Seismic Network (PSN) Event Files●   

SAC Binary and SEED volume Event Files●   

Princeton Earth Physics Project (PEPP) Event Files●   

Public Seismic Network (PSN) Event Files:
Public Seismic Network event files are archived on the Redwood City PSN web site at
http://www.seismicnet.com/. You can use your Web browser, PSN Explorer or FTP program to
download event files from this location. A list of recent event files uploaded to the PSN archive
system can be viewed at http://www.seismicnet.com/cgi-dos/event.exe.

Archived event files can also be accessed using http://www.seismicnet.com/quakes/ or
http://www.seismicnet.com/cgi-dos/eqfiles.exe. This page allows you to search for an event file
based on the year, month and optional day and station ID.

You can download event files using FTP by setting the host address to www.seismicnet.com. Use
"anonymous" (without the quotes) as the User and your email address as the Password. After
logging on, change to the \quakes directory by issuing the following command: "cd quakes". In
this directory is a series of subdirectories based on the year and month of the event. Using the "cd"
command, move to the desired directory. Example: "cd 9805". This will move you to the directory
where all of the event files for 05/98 will be located. Before downloading an event file remember
to issue the following command to place the download mode to binary: "bin". You can now
download the event file. The FTP "dir" command can be used to display contents of a directory.
Each year/month subdirectory contains a file called index.txt. This file can be viewed to see what
events are contained in the directory.

SAC Binary and SEED volume Event Files:
The IRIS (Incorporated Research Institutions for Seismology) system at
http://dmc.iris.washington.edu maintains a database of all earthquakes over magnitude 5. To use
this method, you must have access to Telnet and FTP. Telnet to dmc.iris.washington.edu and use
"bulletin" as the User name and "board" for the password (without the quotes).

At this point you will need to fill out a questionnaire (this will only happen the first time you use
their system). When you get to the main menu type "spy". When asked about X-Server, type a .

Downloading Event Files

http://www.seismicnet.com/wqdocs/evntfile.html (1 of 2) [7/18/2008 6:01:13 PM]

http://www.seismicnet.com/
http://www.seismicnet.com/wqdocs/psnexplorer.html
http://www.seismicnet.com/cgi-dos/event.exe
http://www.seismicnet.com/cgi-dos/eqfiles.exe
http://www.seismicnet.com/cgi-dos/eqfiles.exe


(period), for no X Server. At the main Spyder menu type 1 (one) to select an event. If you just hit
return you will get a list of current quakes. Select the number of the event you what and then go
back to the main Spyder menu.

Then select menu 2 to get the a list of station that you can download seismograms of the event you
selected. Then go back to the main Spyder menu and select 4. At this point you can enter the
station names and file type. Like: *.lhz will select all vertical lh type stations. After selecting the
stations the system will move the files to a download directory for you. Go back to the main menu
and select 5 to download the files to your system. Select option 1 to FTP the files to you system.
The DMC system will now connect to your system using FTP. Enter you account name and
password. After logging in, REMEMBER TO TYPE "BIN". This will place the FTP program into
the binary transfer mode. To transfer the files, type the command "mput *". After the files have
been transferred to your system, type "bye" to exit FTP program and then select quit several times
to logout of the DMC system.

The above process retrieves SAC Binary event files. SEED volumes can be downloaded from the
dmc.iris.washington.edu system using FTP. After logging on using "anonymous" and your email
address, move to the Farm data produces subdirectory. This directory is located in \pub\farm.
There you will find a list of subdirectory listed by year, starting at 1977. Each of these
subdirectories has a list of months. And under each month is a list of subdirectories based on the
event time. After selecting the year, month and event directory you should find a file ending in
*.seed. This is the file you want to download. This file can be several megabytes in size, so it may
take a while to download using a 28k or 33k baud modem.

Princeton Earth Physics Project (PEPP) Event
Files:

PEPP event files can be accessed from their Web site at: http://lasker.princeton.edu/pepp.shtml To
download their event files, use the PEPP Earthquake Database link.
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Advance Information

Contents:
PSN Text Data Format●   

GSE2.0 Data Format●   

Opening an Event File Using DDE●   

Local Data Directory●   

PSN Text Data Format:
WinQuake can read and write event files in a ASCII text format. Foating point numbers will
be rounded to the nearest whole number as the data is read in. A typical event file saved in
the PSN Text format looks like this.

! PSN ASCII Event File Format 1.0 <------ Must be on the first line
Start Time: 2000/01/12 11:33:45.0 <-------Must have this field
Number of Samples: 6100 <------------------Must have this field
SPS: 50.000000 <-----------------------------Must have this field
Comment: Ml~3.2 62km from Kona, Hi. 19 mi. N of Pahala
A/D Converter Bits:
Data Minimum: -1470.000000
Data Maximum: 1522.000000
! Sensor Information:
Sensor Location: Kona Hawaii
Sensor Latitude: 19.723000
Sensor Longitude: -155.991000
Sensor Orientation: Z
! Event Information:
Event Latitude: 19.480000
Event Longitude: -155.440000
Event Time: 2000/01/12 11:34:01.0
Event Magnitude: M 2.4
Event Depth: 6.7
! WinQuake Information:
Magnitude Correction: 0.0018
Mb Magnitude Correction: 0.002
Ms Period: 20.000000
Mb Period: 1.000000
Md Duration:
PS Pick Information: 256 333 188 214 49212
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! SDR Information:
Lock Indicator:
Data:
-2 <------------- First Data Point
-8
[snip]

As you can see, the event file has two parts. The first is the header and then the data starting
after the keyword Data:.  WinQuake does not need all of the fields to read in the event file.
The file must have the first four lines and then the Data: keyword followed by the data.

GSE2.0 Data Format:
WinQuake uses the keyword "BEGIN GSE2.0" to see if a file is in the GSE2.0 format. This
keyword must be within the first 512 bytes of the file. WinQuake supports both single and
multiple seismograms in one GSE2.0 file. If there is more than one seismogram in a file, it
will be treated the same way as a PEPP or SEED volume data set.

The text file STATIONS.GS2 must be in the same directory as the WinQuake program file
(winqk32.exe). This file is used to lookup station latitude and longitude information.

Opening an Event File Using DDE:
WinQuake will open an event file when a DDE (Dynamic Data Exchange) Execute message is
sent to program with the open command. The message format is:

Topic: System
Application: winquake
Open Message format: [open("FILE_TO_OPEN")]

The FILE_TO_OPEN must be the full path and file name of the event file. 

Local Data Directory:
Under the File menu items you will see a menu item called Local Data Directory... This is
used when WinQuake is running on a network/file server setup. If the WinQuake exe file
(winqk32.exe) is located on a server you can specify a local directory on the system that is
running the program. Some of the data and config files (ending in *.dat) should be located
on the local system rather then the server system.

The email.dat, phase.dat and replay.dat files should all be located on the local system. The
other data and bin files should remain on the server system. If you are not running
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WinQuake on a server, this directory should be pointing to the location of the winqk32.exe
file. This is the default setting.
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